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The symbols shown above are internationally accepted symbols
that warn of potential hazards with electrical products. The
lightning flash with arrow point in an equilateral triangle means
that there are dangerous voltages present within the unit. The
exclamation point in an equilateral triangle indicates that it is
necessary for the user to refer to the owner’s manual.

These symbols warn that there are no user serviceable parts
inside the unit. Do not open the unit. Do not attempt to
service the unit yourself. Refer all servicing to qualified
personnel. Opening the chassis for any reason will void the
manufacturer’s warranty. Do not get the unit wet. If liquid is
spilled on the unit, shut it off immediately and take it to a dealer
for service. Disconnect the unit during storms to prevent
damage.

SAFETY INSTRUCTIONS

NOTICE FOR CUSTOMERS IF YOUR UNIT IS EQUIPPED WITH A POWER
CORD.

WARNING: THIS APPLIANCE MUST BE EARTHED.

The cores in the mains lead are colored in accordance with the following code:

GREEN and YELLOW - Earth     BLUE - Neutral        BROWN - Live

As colors of the cores in the mains lead of this appliance may not correspond with
the colored markings identifying the terminals in your plug, proceed as follows:

• The core which is colored green and yellow must be connected to the terminal
in the plug marked with the letter E, or with the earth symbol, or colored green,
or green and yellow.

• The core which is colored blue must be connected to the terminal marked N
or colored black.

• The core which is colored brown must be connected to the terminal marked L
or colored red.

This equipment may require the use of a different line cord, attachment plug, or
both, depending on the available power source at installation. If the attachment
plug needs to be changed, refer servicing to qualified service personnel who
should refer to the table below. The green/yellow wire shall be connected directly
to the units chassis.

WARNING: If the ground is defeated, certain fault conditions in the unit or in the
system to which it is connected can result in full line voltage between chassis and
earth ground. Severe injury or death can then result if the chassis and earth
ground are touched simultaneously.
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LITHIUM BATTERY WARNING

CAUTION!
This product may contain a lithium battery.There is
danger of explosion if the battery is incorrectly replaced.
Replace only with an Eveready CR 2032 or equivalent.
Make sure the battery is installed with the correct
polarity. Discard used batteries according to
manufacturer’s instructions.
ADVARSEL!
Lithiumbatteri - Eksplosjonsfare.Ved utskifting benyttes
kun batteri som anbefalt av apparatfabrikanten. Brukt
batteri returneres apparatleverandøren.
ADVARSEL!
Lithiumbatteri - Eksplosionsfare ved fejlagtig håndtering.
Udskiftning må kun ske med batteri av samme fabrikat og
type. Levér det brugte batteri tilbage til leverandøren.
VAROITUS!
Paristo voi räjähtää, jos se on virheellisesti asennettu.
Vaihda paristo ainoastaan laitevalmistajan suosittelemaan
tyyppin. Hävitä käytetty paristo valmistajan ohjeiden
mukaisesti.
VARNING!
Explosionsfara vid felaktigt batteribyte.Använd samma
batterityp eller en ekvivalent typ som rekommenderas av
apparattillverkaren. Kassera använt batteri enligt
fabrikantens instruktion.

ELECTROMAGNETIC
COMPATIBILITY

This unit conforms to the Product Specifications noted
on the Declaration of Conformity. Operation is
subject to the following two conditions:

• this device may not cause harmful interference,
and

• this device must accept any interference received,
including interference that may cause undesirable
operation.

Operation of this unit within significant ectromagnetic
fields should be avoided.

• use only shielded interconnecting cables.

IMPORTANT SAFETY INFORMATION



IMPORTANT SAFETY INFORMATION

DECLARATION OF CONFORMITY

Manufacturer’s Name: DigiTech
Manufacturer’s Address: 8760 S. Sandy Parkway

Sandy, Utah 84070, USA

Declares that the product:

Product name: Vx400
Product option: all (requires Class II power adapter that conforms to

the requirements of EN60065, EN60742, or
equivalent.)

Conforms to the following Product Specifications:

Safety: IEC 60065 (1998)

EMC: EN 55013 (1990)
EN 55020 (1991)

Supplementary Information:

The product herewith complies with the requirements of the Low Voltage
Directive 73/23/EEC and the EMC Directive 89/336/EEC as amended by
Directive 93/68/EEC.

Vice-President of Engineering
8760 S. Sandy Parkway
Sandy, Utah 84070, USA
Date: May 23, 2003

European Contact: Your local DigiTech Sales and Service Office or

Harman Music Group
8760 South Sandy Parkway
Sandy, Utah  
84070 USA
Ph: (801) 566-8800
Fax: (801) 568-7583

WARNING FOR YOUR PROTECTION

PLEASE READ THE FOLLOWING:

KEEP THESE INSTRUCTIONS

HEED ALL WARNINGS

FOLLOW ALL INSTRUCTIONS

DO NOT USE THIS APPARATUS NEAR WATER

CLEAN ONLY WITH A DRY CLOTH.

DO NOT BLOCK ANY OF THE VENTILATION OPENINGS.
INSTALL IN ACCORDANCE WITH THE MANUFACTURER’S
INSTRUCTIONS.

DO NOT INSTALL NEAR ANY HEAT SOURCES SUCH AS
RADIATORS, HEAT REGISTERS, STOVES, OR OTHER APPARATUS
(INCLUDING AMPLIFIERS) THAT PRODUCE HEAT.

ONLY USE ATTACHMENTS/ACCESSORIES SPECIFIED BY THE
MANUFACTURER.

UNPLUG THIS APPARATUS DURING LIGHTNING STORMS OR
WHEN UNUSED FOR LONG PERIODS OF TIME.

Do not defeat the safety purpose of the polarized or grounding-type
plug. A polarized plug has two blades with one wider than the other.
A grounding type plug has two blades and a third grounding prong.
The wide blade or third prong are provided for your safety. If the
provided plug does not fit your outlet, consult an electrician for
replacement of the obsolete outlet.

Protect the power cord from being walked on or pinched 
particularly at plugs, convenience receptacles, and the point where
they exit from the apparatus.

Use only with the cart stand, tripod bracket, or table specified by the
manufacture, or sold with the apparatus. When a cart is used, use
caution when moving the cart/apparatus combination to avoid injury
from tip-over.

Refer all servicing to qualified service personnel. Servicing is required
when the apparatus has been damaged in any way, such as power-sup-
ply cord or plug is damaged, liquid has been spilled or objects have
fallen into the apparatus, the apparatus has been exposed to rain or
moisture, does not operate normally, or has been dropped.

POWER ON/OFF SWITCH: For products provided with a power
switch, the power switch  DOES NOT break the connection from the
mains.

MAINS DISCONNECT: The plug shall remain readily operable. For
rack-mount or installation where plug is not accessible, an all-pole
mains switch with a contact separation of at least 3 mm in each pole
shall be incorporated into the electrical installation of the rack or
building.

FOR UNITS EQUIPPED WITH EXTERNALLY ACCESSIBLE FUSE
RECEPTACLE: Replace fuse with same type and rating only.

MULTIPLE-INPUT VOLTAGE:This equipment may require the use of
a different line cord, attachment plug, or both, depending on the 
available power source at installation. Connect this equipment only to
the power source indicated on the equipment rear panel.To reduce
the risk of fire or electric shock, refer servicing to qualified service
personnel or equivalent.

U.K. MAINS PLUG WARNING

A molded mains plug that has been cut off from
the cord is unsafe. Discard the mains plug at a
suitable disposal facility. NEVER UNDER ANY
CIRCUMSTANCES SHOULD YOU INSERT A
DAMAGED OR CUT MAINS PLUG INTO A 13
AMP POWER SOCKET. Do not use the mains
plug without the fuse cover in place. Replacement
fuse covers can be obtained from your local retail-
er. Replacement fuses are 13 amps and MUST be
ASTA approved to BS1362.



Warranty
We at DigiTech are very proud of our products and back-up each one we sell with the following warranty:

1.The warranty registration card must be mailed within ten days after purchase date to validate this
warranty.

2. DigiTech warrants this product, when used solely within the U.S., to be free from defects in materials and
workmanship under normal use and service.

3. DigiTech liability under this warranty is limited to repairing or replacing defective materials that show
evidence of defect, provided the product is returned to DigiTech WITH RETURN AUTHORIZATION,
where all parts and labor will be covered up to a period of one year.A Return Authorization number may
be obtained from DigiTech by telephone.The company shall not be liable for any consequential damage as
a result of the product's use in any circuit or assembly.

4. Proof-of-purchase is considered to be the burden of the consumer.

5. DigiTech reserves the right to make changes in design, or make additions to, or improvements upon this
product without incurring any obligation to install the same on products previously manufactured.

6.The consumer forfeits the benefits of this warranty if the product's main assembly is opened and
tampered with by anyone other than a certified DigiTech technician or, if the product is used with AC
voltages outside of the range suggested by the manufacturer.

7.The foregoing is in lieu of all other warranties, expressed or implied, and DigiTech neither assumes nor
authorizes any person to assume any obligation or liability in connection with the sale of this product. In
no event shall DigiTech or its dealers be liable for special or consequential damages or from any delay in
the performance of this warranty due to causes beyond their control.

NOTE:The information contained in this manual is subject to change at any time without notification. Some
information contained in this manual may also be inaccurate due to undocumented changes in the product or
operating system since this version of the manual was completed.The information contained in this version of
the owner's manual supersedes all previous versions.
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Congratulations on your purchase of the Vx400. The Vx400 is truly a breakthrough in vocal processing 
technology, providing the tools you need for live performance and the professional features you need in the
recording studio. We recommend that you take the time to become better acquainted with what the Vx400
has to offer by going through this User’s Guide with your Vx400 in front of you.

Included Items
Before you get started, please make sure that the following items have been included:

• Vx400 Vocal Effects Processor and USB Computer Recording Interface  
• X-Edit Software CD
• Pro Tracks™ Recording Software
• USB Cable
• PS0913B Power Supply
• Warranty Card

The utmost care was taken while your Vx400 was being manufactured. Everything should be included and
in perfect working order. If anything is missing, contact the factory at once. Please help us become
acquainted with you and your needs by completing your warranty card. It is your safeguard should a 
problem arise with your Vx400.

The Front Panel

1. Down/Up Footswitches - These two footswitches are used to select presets, or access the Tuner of the
Vx400. The footswitch on the left decreases, and the middle footswitch increases the preset
number. Press and hold both Footswitches to access the Tuner.

2. Bypass Footswitch - This footswitch bypasses the selected preset. It is also used in conjunction with the
Up Footswitch to access the recorder functions when the Vx400 is connected to your computer
via USB. 1

Introduction



3. Knobs - These knobs perform various functions depending on which mode is selected or whether the
Vx400 is connected to your computer via USB. During performance, the knobs control the Bass
EQ, Mid EQ, Mid Frequency,Treble EQ, and Master Level. If the Vx400 is connected to the 
computer via USB, the performance functions of knobs 2, 3, and 4 are Playback Mix, USB 1-2 Send
Level, and USB 3-4 Send Level. When editing or accessing the Setup functions, the knobs adjust
the parameter values listed directly above each knob for the selected effect. When the Drum
Machine is on, the knobs control the Pattern,Tempo, and Level. In Tuner mode, the knobs are
used to select the tuning reference.

4. Select Button - This button enters the Edit mode and selects individual effects to be edited. Successive
presses of this button advances through all available effects. You can also use the select
button to perform two shortcuts. First, you can exit from anywhere within Edit mode by
pressing and holding the Select button. Second, you can move directly to the setup row of
the Matrix while in Performance mode by pressing and holding the Select button.

5. Drums - The Drums button turns the built-in drum machine on and off. When the drum machine is
active, the Drums LED lights and the selected drum pattern plays continuously.

6. Matrix - The matrix provides information regarding the current preset, and parameter edit functions. In
performance mode, the LED’s running down the left side of the Matrix identify which effects are
in use for the selected preset. In Edit mode, the LED's indicate the effect selected for editing.

7. Display - The display provides information for different functions depending on the mode that is active. In
Performance mode, the display shows the selected preset name and numeric location. In Edit
mode, the display shows the name and value of the selected parameter. In Tuner mode, the 
display shows the note being played and whether the note is sharp, flat, or in tune.

8. Store - The Store button saves your changes to a User Preset.

9. Expression Pedal - The Expression Pedal controls up to three of the Vx400’s simultaneously assigned Effect
Parameters in real time. Almost every Parameter is available for Expression Pedal 
control.

Rear Panel

1. Instrument In - Connect your instrument to this jack.

2. Mic Level - Controls the gain of the Mic Input.

Introduction
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3. Mic Input - Connect a mic here for recording or live performance mixing of acoustic sources into the
Vx400. Mic signals can remain dry or be processed through the Vx400 effects for both live
and recording applications. The Mic Input accepts either dynamic or phantom powered 
condenser microphones.

4. Left/Right Line Inputs - Connect line level sources to these jacks for recording or live performance mixing
into the Vx400. Line signals can remain dry or be processed through the Vx400
effects for live and recording applications.

5. CD/Monitor In - Connect the output of a CD or MP3 player headphone out for listening to music. The
CD/Monitor In can also be used as a monitor input for mixing the output of your 
computer’s sound card back into the Vx400 for playback monitoring.

Note: Using the CD/Monitor input for any type of real-time recording monitoring may
result in a time delay depending on your computer’s speed.

6. Headphones - Connect a pair of stereo headphones to this 1/8” jack.

7. 1/4” Line Outputs - Connect these outputs to your amplifier or to a mixing console that accepts 1/4”
unbalanced connections.

8. Balanced Line Outputs- Connect these outputs to your power amplifier/speaker system or to a mixing
console that accepts balanced XLR connections.

9. USB Jack - Connect this jack to your computer’s USB port for recording purposes (see page 25 for more
on using the Vx400’s USB functions).

ATTENTION: The Vx400 can be connected to your computer before installing the USB
drivers if you are using Windows XP™. However, if you are using any software other than
Windows XP, you must install the USB drivers provided on the X-Edit Software CD before
connecting the Vx400 to your computer with the USB cable.

10. Footswitch jack - Connect the RPxFC 3-button footswitch to this jack.The RPxFC provides remote
control of the recording functions of the Vx400 (see page 31 for more on using the
RPxFC functions).

11. Power Input - Connect only the DigiTech PS0913B power supply to this jack.

3
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Making Connections
There are several different connection options available with the Vx400. Before connecting the Vx400, make
sure that the power to your amplifier and the Vx400 is turned off. The Vx400 does not have a power switch.
To turn the Vx400 off, disconnect the included PS0913B power supply from the power jack to an AC outlet.

PA Rig
Connect your microphone to the Input of the Vx400. Connect the balanced XLR Left and Right outputs
to the inputs on your PA mixer and pan each of these channels hard left and hard right. Select FULL as
your Output Mode (see Output Modes on pg 19 on how the XLR and 1/4” outputs can be 
implemented for various recording and live applications).

Recording Setup
This is the classic recording setup utilizing the Vx400’s mic, instrument and line inputs with a pair of 
powered reference monitors connected the Vx400’s XLR outputs. This setup can also be used for live
applications where you would be performing along with playback from the Pro Tracks recording software
running on your computer (see the Output Modes section on page 19 on how the XLR and 1/4” 
outputs can be implemented for various recording and live applications).

USB Ports
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Applying Power 
Before applying power to anything, set your mixer to a flat EQ response (on most mixers, this would be
0). Then do the following:
1. Pull the Mixer’s Master Faders down completely.
2. Connect the plug of the PS0913B power supply to the Power Jack.
3. Connect the other end of the PS0913B power supply to an AC outlet.
4. Turn the Vx400 Master Volume up to 70 (70).
5. Push the Mixer’s Master Faders up to your desired level.

5
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The Presets
Presets are named and numbered locations of programmed sounds which reside in the Vx400. Presets are
recalled with the footswitches. The active effects in each preset are indicated by the lighted LED's in the
Effect Matrix. The Vx400 comes with 40 User Presets (Presets 1-40), and 40 DigiTech factory presets (41-
80). The User Presets are locations where you can store your edits. You may not store changes to the
Factory Presets. From the factory, the 40 User Presets are exact duplicates of the 40 Factory Presets.

Performance
When you first apply power to the Vx400, it powers up in Performance mode. Performance mode provides
access to all of the presets within the Vx400 via the Up and Down Footswitches. The Number 1 Knob (left)
adjusts the Bass, the Number 2 Knob (second from the left) adjusts the amount of Midrange enhancement,
the Number 3 Knob (middle) adjusts the Mid Frequency, the Number 4 Knob (second from the right) adjusts
the amount of Treble (high frequency) enhancement, and the Number 5 Knob (right) adjusts the Master Level
(volume).

Bypass
The Vx400 Presets can be bypassed for clean, unprocessed vocals and instrument signals. To bypass the
Vx400, press the BYPASS Footswitch. The display will read Bypass indicating the preset is bypassed.
Pressing the Up or Down Footswitches advances to the next available preset. Pressing the Bypass
Footswitch again exits you from Bypass and loads that preset.

Tuner
The Tuner lets you quickly tune or check the tuning of any instrument plugged into the Vx400. Enter Tuner
mode by pressing and holding the Up and Down Footswitches simultaneously. The display briefly shows
tuner indicating that you are in Tuner mode. To begin tuning, play a note on your instrument (a harmonic at
the 12th fret usually works best for guitars). The right 2 characters in the display shows the note being
played. The left characters in the display indicate whether you are sharp or flat. Arrows pointing to the left
(<<<) indicate the note is sharp and should be tuned down. Arrows pointing to the right (>>>) indicate the
note is flat and should be tuned up. When the note is in tune, the display shows --><--.

In Tuner mode, you can change your tuning reference. The default factory setting is A=440 Hz. (displayed as
A=440). Rotate the Number 1 Knob to select alternate dropped tunings. Alternate tunings are A = Ab ,A =
G , and A = Gb. The display window briefly flashes the selected tuning preference.

The output is muted in Tuner mode. The Expression Pedal returns sound to the output allowing signal to be
heard while tuning. Exit tuner mode by pressing any of the 3 Footswitches.

>>><<< A
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CD/Monitor In
The CD In feature lets you connect a CD, MP3, or tape player to the Vx400, and play along with your favorite
artists. To use the CD In feature, do the following:

1. Connect the headphone output of your MP3/CD/tape player to the CD/Monitor input using an 1/8”
stereo cable.

2. Press play on your MP3/CD/tape player. The signal from your MP3/CD/tape player is routed to the left,
right, and headphone outputs of the Vx400.

The Monitor In feature can also be used as a monitor input for mixing the output of your computer’s sound
card back into the Vx400 for playback monitoring.

Drum Machine
The Vx400 features a Drum machine that includes several sampled drum patterns which are useful for 
developing a good sense of timing. Pressing the Drums button turns on the built-in drum machine (except
when in Store or Bypass mode). When the drum machine is active:

The Number 1 Knob is used to select the drum Pattern. Choices include:

The Number 2 Knob adjusts the drum Tempo and ranges from BPM 40 (40 beats per minute) to BPM240
(240 beats per minute).
The Number 3 Knob adjusts the volume Level of the drum loop and ranges from 1 to 99.
Press the Drums button again to stop playback of the drum loop.

Mic Input and Level
The Vx400 features a mic input that can be used for mixing or recording vocals and acoustic instruments.
The mic input is equipped with phantom power that can power professional condenser microphones. The
mic preamp is controlled via the Mic Level knob for controlling the gain of the mic signal. To set the mic level
control, follow these steps:

1. Connect a set of headphones to the headphone jack.
2. Sing or play at the loudest volume you will be performing at and adjust the mic Level control until you see

the Clip LED at the top of the Matrix light. Then gradually decrease the control until the light goes out.
This is the optimum setting for the Mic Level.

For application uses of the mic input, see both the Making Connections and Vx400 Setups sections of
this user’s guide.

ROCK 1

ROCK 2

ROCK 3

HROCK1

HROCK2

HROCK3

HROCK4

POP1

POP2

POP3

POP4

POP5

DANCE1

DANCE2

DANCE3

cntry1

cntry2

blues1

blues2

jazz

funk 1

funk 2

swing1

swing2

urban1

urban2

reggae

cha 1

cha 2

BOSSA 

mtrnom
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Editing/Creating Presets
Creating your own signature sound with the Vx400 is easy and intuitive. The Vx400 lets you create your own
presets, or fine tune existing presets to suit your needs. When creating or editing a sound, you must start
with one of the User or Factory Presets. It is not possible to start with an empty preset. The preset number
does not need to be the location that you intend to save it to, because you can save it to any User Preset
location during the store process.

To edit or create a Preset:
1. Use the Up or Down Footswitches to select a preset.
2. Once you have found a preset that you want to edit, press the Select button once to enter Edit mode.
3. Use the Select button in conjunction with the Matrix LED's to choose the effect you want to edit.

Successive presses of the Select button advance to the next Effect in the Matrix.
4. Use Knobs 1-4 to change parameter values.
5. Store your preset (See this page for more on storing a preset).

The Matrix
The Matrix identifies the effects and parameters selected for editing. In Edit mode, successive presses of the
Select button advances to the next row of effects. The LED lights indicating which effect group is selected.
Each effect group has up to 4 parameters that can be modified. The knob directly below each column is used
to change the parameter value of the selected effect. As a knob is rotated, the corresponding parameter’s
name and value or status are displayed.

When the stored value of a parameter is changed, the Store LED lights indicating you need to store the
changes. Changing presets, or turning the power off before storing erases all changes made and the Vx400
reverts to the stored values for the preset.

Storing/Copying/Naming a Preset
Once the preset is modified, you may store your settings to any of the 40 User Preset locations (Presets 1-
40). The following steps outline the procedure for storing changes to a preset or copying a preset to a 
different location:

1. Press the Store button once. The Store button LED blinks and the first character in the display flashes
indicating you can name your new preset.

2. Use Knob 1 or Up/Down Footswitches to select the alpha-numeric character.

LO-FI  17
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3. Rotate Knob 2 clockwise to select the next character, and counterclockwise to select the previous 
character. Repeat step 2 until the name is complete.

4. Once the name is shown in the display, press the Store button. The display will then flash the new name
of the preset.

5. Select the User Preset location of your new preset using Knob 5 or the Up/Down Footswitches. The
display will then flash the new name of the preset.

6. Press the Store button again to save the changes.

Press the Select or Drums buttons at any time to abort storing.

To copy one preset to another preset location is the same as above. Use the footswitches to select the 
preset that you want to copy, then follow the steps listed above.

9
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Vx400’s Effects
About the Effects
The Vx400 can be thought of as having several different microphone and rack effect processors in a single
programmable package. The order in which they are connected can drastically affect the overall sound 
quality. The Vx400 has placed the effects in an order for optimum sound quality. The following diagram
shows the order of the effects.

Effect Definitions
Each effect within the Vx400 can be programmed to suit your personal taste and application. Understanding
how these effects alter the sound, and how each parameter alters the effect helps you achieve the sound you
are looking for.The following overview of the Vx400’s effects outlines what each effect and parameter does.

Mic Modeling
Using proprietary algorithms, DigiTech engineering built precise models of a variety of popular 
microphones. This technology allows you to make a composite microphone model by removing the 
characteristics of a typical dynamic or condenser mic and adding the characteristics of the desired 
microphone sound.

Modeling On/Off - The Number 1 Knob turns the Mic Modeling effect on (On) and off (Of).
Source Mic - The Number 2 Knob selects your Source Mic type. There are two types to choose from,

(Dynamic (dynamc) or Condenser (conden).
Modeled Mic - The Number 3 Knob selects the Mic Model type. See list below for Mic Model types and

descriptions.

Microphone Model Descriptions/Display Names

Microphone Description Display Name
AKG™ 414 TLII Large Diaphragm Condenser GLDGRL

Neumann™ U87 AI Large Diaphragm Condenser BIG 87

AKG™ C12 Large Diaphragm Tube TUBE

Oktava™ Small Diaphragm Condenser PENCIL

Shure™ SM58 Small Diaphragm Dynamic 58 DYN

Royer™ 121 Ribbon Microphone RIBBON

Mic Model

10
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Shure™ Green Bullet Large Diaphragm Dynamic - BULLET

Harmonica Mic
Brawner™ VM1 Large Diaphragm Condenser BRAWNY

Neumann™ M149 Large Diaphragm Condenser NEU149

Lawson™ L47MP Large Diaphragm Tube LAWLES

AKG™ 414 ULS Large Diaphragm Condenser SLVGRL

Sennheiser™ 421 MD Large Diaphragm Dynamic SENDYN

Audio Technica™ AT4050 Large Diaphragm Condenser ATCOND

Neumann™ KM184 Large Diaphragm Condenser NEU184

Scheops™ MK21 Small Diaphragm Condenser SHEP21

Shure™ KSM32 Large Diaphragm Condenser KISSEm

Shure,AKG,Audio Technica, Neumann, Lawson, Oktava, Royer, Brawner, Sennheiser, and Scheops are Registered trademarks of their respective companies. The aforementioned names and models are
used solely to indicate microphones used for analyzation in the development of this product. It is not implied in any way that there is any association with or endorsement by any of the named 
manufacturers.

Compressor/Noise Gate
The Compressor/Noise Gate module is used to control the dynamics of varying signal strengths and 
eliminate unwanted noise when a signal isn’t present.

Comp On/Off - The Number 1 Knob turns the Compressor on (On) and off (Of).
Amount - Rotate the Number 2 Knob to adjust the amount of Compression you want applied to the 

signal. Ranges from 1 to 20.
Gain - Rotate the Number 3 Knob to increase the compressor’s output gain. Ranges from 0 to 10dB.
Gate Off/Threshold -  Rotate the Number 4 Knob to turn the Noise Gate off (Of) and to adjust the

threshold level. Ranges from 1 to 99. A higher setting requires a stronger signal to
open the gate.

Mic Pre/Voice
This module selects various Mic Preamp and Voice character types. Tube Pre is a warm professional mic
preamp type for standard vocal usage. Overdrive and Grunge are cutting edge distortion preamp types.
The other nine voice characters produce wild and unnatural vocal sounds.

Voice Type/Off -  The Number 1 Knob selects a vocal type and turn the Mic Pre/Voice types on (On) and
off (Of) (see Mic Pre/Voice Type Parameter chart following these for parameter 
descriptions).

Parameter 1 -  The Number 2 Knob adjusts the first parameter of the Voice type selected (see Voice
Parameter chart following these instructions).

Parameter 2 -  The Number 3 Knob adjusts the second parameter of the Voice type selected (see Voice
Parameter chart following these instructions).

Level -  The Number 4 knob controls the preset level for the selected type. Ranges from 0 to 99
Master Level - The Number 5 Knob controls the Vx400’s Master Level.

Mic Pre / Voice Parameters
Voice Type Param 1 Range Param 2 Range
Direct ---- ---- ------ ----

Tube Pre Gain 0-15 De Ess 1-50
Overdrive Gain 0-50          De Ess 1-50
Grunge Gain 0-50          De Ess 1-50 11
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Dark Side Breath 1-20 ------ ----

Monster Size 1-60 Growl 1-40
Chipmunk Size 1-30 ------ ----

Lunar Range 1-10 ------ ----

Lo-Fi drive 0-50 Subfrq (Sub Freq.) 1-18
Robot Range 1-50 EdGE 1-50
Wizard Range 1-50 ------ ----

Alien RaTE 1-40 Intens (Intensity) 1-50
Telephone SubFRQ (Sub Freq.) 1-35 siblnc (Sibilance) 1-50

EQ
The EQ module is a 3-band EQ consisting of Bass, Midrange, and Treble.The frequency centers for each
band may vary depending on the selected model.

Bass -  The Number 1 Knob adjusts the low frequency gain. Ranges from -12 to +12dB.
Midrange -  The Number 2 Knob adjusts the midrange frequency gain. Ranges from -12 to +12dB.
Mid Frequency - The Number 3 Knob adjusts the midrange frequency. Ranges from 100Hz to 4000Hz.
Treble -  The Number 4 Knob adjusts the high frequency gain. Ranges from -12 to +12dB

Mod Effects
The Effects row in the Vx400 is a multi-function module allowing you to select effects such as: Chorus,
Flanger, Phaser,Tremolo,Vibrato, Strobe, Doubler, Envelope, Pixelator, Detune, Pitch, and Whammy™
effects. When the Effects row is selected, the Number 1 Knob is used to turn the Effect module on or
off (EFFECT OF), and select the type of Effect to be used. After selecting the type of effect in this 
module, the Number 2-4 Knobs can then be used to adjust the individual Parameters associated with the
selected effect. The Number 5 Knob controls the Vx400’s Master Level. The following describes each
Effect and their Parameters in more detail:

Chorus
A Chorus adds a short delay to your signal. The delayed signal is modulated in and out of tune and
then mixed back with the original signal to create a thicker sound.

Parameter 1 -The Number 2 Knob adjusts the rate (Speed) of the modulation. Ranges from 1 to 99.
Parameter 2 - The Number 3 Knob adjusts the intensity (Depth) of the modulation. Ranges from 1

to 99.
FX Level - The Number 4 Knob controls the volume of the Chorus. Ranges from 0 to 99.
Master Level - The Number 5 Knob controls the Vx400’s Master Level.

Flanger
A Flanger uses the same principle as a Chorus but uses a shorter delay time and adds regeneration
(or repeats) to the modulating delay. This results in an exaggerated up and down sweeping motion to
the effect.

Parameter 1 - The Number 2 Knob adjusts the rate (Speed) of the modulation. Ranges from 1 to 99.
Parameter 2 - The Number 3 Knob adjusts the intensity (Depth) of the modulation. Ranges from 1

to 99.
FX Mix - The Number 4 Knob controls the mix of wet and dry signal. Ranges from 0 (all dry) to 99

(all wet).
12
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Master Level - The Number 5 Knob controls the Vx400’s Master Level.

Phaser
A Phaser splits the incoming signal, and then changes the phasing of the signal. This signal is then taken in
and out of phase and mixed back in with the original signal. As the phasing changes, different frequencies
get canceled resulting in a warm sort of twisting sound.

Parameter 1 - The Number 2 Knob adjusts the rate (Speed) of the modulating phase. Ranges from 1 to
99.

Parameter 2 - The Number 3 Knob adjusts the intensity (Depth) of the modulating phase. Ranges from 1
to 99.

FX Level - The Number 4 Knob controls the volume of the Phaser. Ranges from 0 (all dry) to 99.
Master Level - The Number 5 Knob controls the Vx400’s Master Level.

Tremolo
A Tremolo effect modulates the volume of the signal at an even rate.

Parameter 1 - The Number 2 Knob adjusts the rate (Speed) the volume modulates. Ranges from 1 to 99.
Parameter 2 - The Number 3 Knob adjusts the intensity (Depth) of the modulating volume. Ranges from 0 (all dry) to

99.
The Number 4 Knob has no function when the Tremolo effect is selected.
Master Level - The Number 5 Knob controls the Vx400’s Master Level.

Vibrato
A Vibrato effect modulates the pitch of the incoming signal at an even rate.

Parameter 1 - The Number 2 Knob adjusts the rate (Speed) at which the pitch modulates. Ranges from 1
to 99.

Parameter 2 - The Number 3 Knob adjusts the intensity (Depth) of the modulating pitch. Ranges from 1 to 99.
The Number 4 Knob has no function when the Vibrato effect is selected.
Master Level - The Number 5 Knob controls the Vx400’s Master Level.

Strobe
The Strobe is a tremolo effect that uses a square wave LFO for the modulation of the signal.

Parameter 1 - The Number 2 Knob to adjust the rate (Speed) at which the LFO modulates. Ranges from
1 to 99.

Parameter 2 - The Number 3 Knob controls the intensity (Depth) of the Effect. Ranges from 0 to 99.
The Number 4 Knob has no function when the Strobe effect is selected.
Master Level - The Number 5 Knob controls the Vx400’s Master Level.

Doubler
The Doubler effect adds a slightly delayed signal to the input signal creating a thicker sound as the level is
increased.

FX Level - The Number 4 Knob controls the volume of the doubled signal. Ranges from 0 (all dry) to 99
(all wet).

The Number 2, and 3 Knobs have no function when the Doubler effect is selected. 13
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Master Level - The Number 5 Knob controls the Vx400’s Master Level.

Envelope  
The Envelope is an automatic Wah effect that alters your sound based upon the dynamic attack of the
vocal part being sung or instrument being played.

Parameter 1 - The Number 2 Knob adjusts the amount of Wah sweep once the Wah is triggered.
Ranges from 1 to 99.

Parameter 2 - The Number 3 Knob adjusts the sensitivity or the input signal required to trigger the
Wah effect. Ranges from 1 to 99.

FX Mix - The Number 4 Knob controls the mix of wet and dry signal. Ranges from 0 (all dry) to 99
(all wet).

Master Level - The Number 5 Knob controls the Vx400’s Master Level.

Pixelator
The Pixelator effect removes random samples from the input signal which in turn reduces the signal's
quality and creates a granular type effect on the source  Higher Amount settings remove more 
samples which reduces the signal's intelligibility.

Parameter 1 - The Number 2 Knob adjusts the amount of random samples being removed from the
source signal. Ranges from 1 to 50.

Parameter 2 - The Number 3 Knob adjusts the edge of where the sample is being removed. Ranges
from 0 to 99.

FX Mix - The Number 4 Knob controls the mix of wet and dry signal. Ranges from 0 (all dry) to 99
(all wet).

Master Level - The Number 5 Knob controls the Vx400’s Master Level.

Detune
A Detuner will make a copy of your incoming signal, take the copied signal slightly out of tune from
the original, and mix the two signals together. The result is a doubling type of effect as if two vocal
parts were being sung together or two instruments were playing the same part together.

Parameter 1 - The Number 2 Knob adjusts the amount of pitch difference applied to the copied 
signal. Ranges from -24 to 24.

FX Level - The Number 4 Knob controls the volume of the detuned note. Ranges from 0 to 99.
Knob’s 3 has no function when the Detune effect is selected.
Master Level - The Number 5 Knob controls the Vx400’s Master Level.

Pitch
A Pitch Shifter copies the incoming signal, then shifts the pitch of the copied note to a different note.
The shifted note is then mixed back with the original signal sounding as if two vocal parts were being
sung in harmony or two instruments were playing in harmony.

Parameter 1 - The Number 2 Knob adjusts the interval of shifted pitch. Ranges from -24 (semitones
below) to 24 (24 semitones above).

FX Level - The Number 4 Knob controls the volume of the shifted pitch. Ranges from 0 to 99.
The Number 3 Knob has no function when the Pitch Shift effect is selected.
Master Level - The Number 5 Knob controls the Vx400’s Master Level.14
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Whammy™
Whammy™ is an effect that uses the Expression Pedal to bend the pitch of the incoming signal, or add a
bendable harmony with the original signal. As the Pedal is moved, the note will bend either up or down.
The Whammy™ effect must be linked to the Expression Pedal in order to function. See page 16 for
more information on linking the Expression Pedal.

Parameter 1 - The Number 2 Knob selects the interval and direction of the pitch bend. Choices are as
follows:

FX Level - The Number 4 Knob adjusts the volume of the Whammy™. Ranges from 0 to 99.
The Number 3 Knob has no function when the Whammy™ is selected.
Master Level - The Number 5 Knob controls the Vx400’s Master Level.

Note: Only one of the effects in the Effects row can be used at a time.

Delay
Delay is an effect that will record a portion of the incoming signal, and then play it back a short time later.
The recording can repeat just once, several times, or infinitely (which turns off the input to the Delay and
allows you to play over the top of a passage in the Delay loop).

Delay Type/Off - The Number 1 Knob turns the Delay on (On) and off (OF) and selects one of the 3 
different types of Delay. Values include: DIGTAL (Digital Delay), ANALOG (Analog Delay),
P PONG (Ping Pong Delay).

Delay Time - The Number 2 Knob adjusts the amount of Delay time. Ranges from 10 MS through 2
Sec (10 ms through 1 sec in 10 ms increments and 1 sec through 2 sec in 100 ms incre-
ments).

Feedback - The Number 3 Knob adjusts the number of times the delayed signal will repeat. Ranges from
1 to 99 and repeat hold (infinite repeat).

Delay Level - The Number 4 Knob adjusts the volume of the delayed signal. Ranges from 0 to 99.
Master Level - The Number 5 Knob controls the Vx400’s Master Level.

Reverb 
Reverb can give the listener a sense that the material is being performed in various acoustical 
environments. It can provide the tight acoustics of a small room, or the ambience of huge arena.

Reverb Type/Off - The Number 1 Knob selects the Type of Reverb or acoustic environment and turns the
Reverb off (OF) or on (oN). The Vx400 provides your choice of eight different 
environments including:

Whammy (no Dry Signal)
1OCTUP (1 octave above) 
2OCTUP (2 octaves above)
2NDDWN (a second below)
REV2ND (a second below reversed pedal

action)
4THDWN (a fourth below)
1OCTDN (an octave below)
2OCTDN (2 octaves below)
DIVBOM (Dive Bomb)

Harmony Bends (Dry Signal Added)
M3>MA3 (a minor third to a Major third)
2NDMA3 (a second above to a Major third

above) 
3RD4TH (a third above to a fourth above) 
4TH5TH (a fourth above to a fifth above) 
5THOCT (a fifth above to an octave above)
HOCTUP (one octave above)
HOCTDN (one octave down)
OCTU>D (one octave up to one octave down)
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Decay - The Number 2 Knob adjusts the length of time the Reverb is audible. Ranges from 1 to 99.
Damping - The Number 3 Knob controls the amount of sound which is absorbed in the simulated 

environment. Ranges from 0 to 99.
Reverb Level - The Number 4 Knob adjusts the volume of the Reverb. Ranges from 0 to 99.
Master Level - The Number 5 Knob controls the Vx400’s Master Level.

Expression Pedal
The Expression Pedal on the Vx400 can be assigned to control the Vx400’s Volume,Whammy™, or just
about any other parameter in real time with your foot. When a parameter has been assigned to the
Expression Pedal, a programmable minimum and maximum value can also be assigned. The procedure for
assigning a parameter to the Expression Pedal is as follows:
1. Select a User or the Factory Preset.
2. Press the SELECT button until the light in the Expression row of the Matrix’s LED begins flashing.
3. Rotate the Number 1 Knob to select the Expression pedal 1,2, or 3.

Note: You can assign three parameters to the Expression pedal per preset.

4. Rotate the Number 2 Knob to select the parameter the pedal will control.
5. Rotate the Number 3 Knob to adjust the minimum value the pedal (toe up) reaches.
6. Rotate the Number 4 Knob to adjust the maximum value the pedal (toe down) reaches.
7. Press the STORE button to store the changes. See page 8 for more information on storing presets.

The following is a list of the parameters that can be assigned to the Expression pedal:
(Voice and Effect Parameters depend on the type that is currently selected).

Parameter Display Min Value Max Value
Voice Param 1 Varies Varies Varies
Voice Param 2 Varies Varies Varies
Voice Level VOXLVL 1 99
Effect Speed param 1 Varies Varies
Amount/Depth Param 2 Varies Varies
Effect Level FXLEVL 0 99
Effect Mix FX MIX 0 99
Whammy WHMAMT 1 99
Delay Feedback FBACK 1 99 R-hold
Delay In Level DLY IN 0 99
Delay Out Level DLY OUT 0 99
Reverb Decay DECAY 1 99
Reverb In Level Rvb IN 0 99
Reverb Out Level RVbOUT 0 99
Volume Pre VOLPRE ----- -----
Volume Post VOLPST ----- -----

HALL = Hall
PLATE = Plate
ROOM = Wood Room  
CHAMBER = Chamber 

GARAGE = Parking Garage
CHURCH = Church
ARENA = Arena
SPACE = Space

16

Creating Presets



V-Switch
The Vx400’s Expression Pedal includes DigiTech’s exclusive V-Switch. The V-Switch allows the Voice Type
to be switched on and off. Applying extra pressure to the toe of the Expression Pedal will engage the V-
Switch and the function of the Expression Pedal will switch between the assigned parameter and Voice off.
The sensitivity or amount of pressure required to engage the V-Switch can be adjusted to suit your 
personal taste (or weight of your foot). See page 32 for the V-Switch Sensitivity adjustment procedure.
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Setups Introduction
The Vx400 is equipped with four inputs and four outputs that can be configured several different ways for
both live and recording applications. These configurations are selected in the DRUMS/SETUP row of the
editing matrix using the five editing knobs. Settings include whether the Instrument or Line inputs are routed
through the Vx400’s effects processing and which pair of outputs mic, line, and instrument processing are
routed to. The USB 1-2 Source and USB 3-4 Source knobs are used for configuring how all inputs, mic
processing, and drum machine are routed via USB to the computer for recording applications.

Instrument/Line Setups
The Instrument and Line Setups are configurations for the instrument and line inputs designed primarily
for live performance applications. The Vx400 acts as a mixing device for mic, instrument, and line sources,
and can eliminate the need for a mixer when the Vx400’s outputs are to be plugged directly into a 
full-range powered speaker system. When enabled, these inputs can be routed around or through the
Vx400’s effects processing and then mixed directly into the Vx400’s 1/4” and XLR outputs.

Both Instrument and Line inputs have four settings that can be independently selected using the
Instrument and Line knobs in the DRUMS/SETUP row of the effect matrix. The configurations are
as follows:

InsOFF / LINOFF - Instrument and Line inputs are disabled.
insDRY / LINDRY - Inputs routed directly to Vx400’s outputs, bypassing all effects processing.
insRVB / LINRVB - Inputs routed through delay and reverb effects of the current preset.
insFX / LINEFX - Inputs routed through all effects of current preset.

Instrument Routing

Line Input Routing

Line Left

Line Right

+

Line = linefx Line = linrvb Line = lindry

Mic
Model Comp EQ

Noise
Gate Effects Delay Reverb

+ + XLR Left Output
XLR Right Output

1/4" Left Output
1/4" Right Output

Mic Pre
Voice

+

+

+

+

Instrument Input
Instrument = insfx

  Mic
Model Comp Mic Pre

Voice
EQ

Noise
Gate Effects Delay Reverb

+

+

+

+

XLR Left Output
XLR Right Output

1/4" Left Output
1/4" Right Output

+

+

Instrument = insrvb Instrument = insdry
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Output Modes
The Vx400 features both 1/4” and XLR outputs on the rear panel. These jacks let you simultaneously
connect the Vx400 to an amplifier/speaker system on stage via the 1/4” outputs and connect directly to
your PA system via the XLR outputs.
The five output modes for the Vx400 are as follows:

Full - All input sources are routed out 1/4” and XLR outputs.

XLRdry - The dry Mic signal is routed out the XLR outputs only. All other sources and Mic with all
Effects are routed out the 1/4” outputs.

XLRMOD - The Mic signal with Modulation Effects is routed out the XLR outputs only. All other sources
and Mic with all Effects are routed out the 1/4” outputs.

Line Right

Mic In

Instrument In

Line Left

Mic
Model Comp

Mic Pre
Voice

    DRUMS

EQ
Noise
Gate Effects Delay Reverb

+ +
+

XLR Left Output
XLR Right Output

1/4" Left Output
1/4" Right Output+

+

Instrument = InsfX

Line = Linefx

Instrument = insrvb

Line = linrvb

Instrument = insdry

Line = lindry

Line Right

Mic In

Instrument In

Line Left

Mic
Model Comp

Mic Pre
Voice

    DRUMS

EQ
Noise
Gate Effects Delay Reverb

+ +

+

XLR Left Output
XLR Right Output

1/4" Left Output
1/4" Right Output+

+

Instrument = InsfX

Line = Linefx

Instrument = insrvb

Line = linrvb

Instrument = insdry

Line = lindry

Line Right

Mic In

Instrument In

Line Left

Mic
Model Comp

Mic Pre
Voice

    DRUMS

EQ
Noise
Gate Effects Delay Reverb

+ +

+

XLR Left Output
XLR Right Output

1/4" Left Output
1/4" Right Output+

+

+
+
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1/4DRY - The dry Mic signal is routed out the 1/4” outputs only. All other sources and Mic with all
Effects are routed out the XLR outputs.

1/4MOD - The Mic signal with the Modulation Effects is routed out the 1/4” outputs only. All other
sources and Mic with all Effects are routed out the XLR outputs.
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Line Left
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+ +
+
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+
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Recording Introduction
The Vx400’s USB connection provides 4 channels of audio streaming into the computer and 2 channels of
playback from the computer simultaneously. Recording has never been easier thanks to the hands-free 
tracking environment that the Vx400 and Pro Tracks™ software provide. The Vx400’s footswitches and Pro
Tracks software work seamlessly together to automatically arm, record, play, and delete tracks totally hands
free. Multiple recording configurations can be selected to best optimize your recording needs. These 
configurations are accessed via the Vx400’s effect’s matrix in the DRUMS/SETUP row.

To begin recording you must first install the proper USB drivers and Pro Tracks recording software onto your
Windows® compatible PC. The USB drivers are found on the X-Edit™ Software CD that came packaged
with the Vx400 and the Pro Tracks recording software CD is found in the Pro Tracks box. Please review the
Pro Tracks documentation to ensure your computer system meets the necessary requirements prior to 
installation and refer to the DigiTech Software Installation Guide for step by step installation instruc-
tions. Once installed and configured, the Vx400 can then control Pro Tracks and its recording functions.

Connecting the Vx400 to the Computer
The Vx400 comes equipped with a USB cable that is to be connected to your computer whenever you
will be recording or using the X-Edit Editor/Librarian. We recommend that you only use the USB cable
that is shipped with the Vx400 since it has been tested and approved for this specific use. To connect the
Vx400 to the computer, follow these steps:

• Before connecting the Vx400’s USB jack to your computer, consult the DigiTech Software
Installation Guide and follow the instructions for your computers operating system.

1. Begin with the power disconnected from the Vx400.
2. Plug the small end of the USB cable in to the USB jack on the back of the Vx400.
3. Plug the large flat end of the USB cable into an available USB port on your computer.
4. Connect power to the Vx400.

Vx400 Recording Setup
The Vx400 has several different input / output configurations called Setups offering a wide variety of
recording possibilities. These are selected using the USB 1-2 Source and USB 3-4 Source knobs in
the Vx400’s effect matrix. For a given recording session, you may want to record a mic with effects, dry
mic, instrument, line inputs, a combination of these, or even re-mic your dry vocal tracks back through the
Vx400. Up to 4 channels of audio can be sent simultaneously to the computer and the knobs in the
SETUP row select how and which audio signals are routed up the USB connection. Each USB Source
routes a pair of signals to the computer. The following sections outline how these signals are routed:

USB 1-2 Source
STEREO - All input sources that are routed through the Vx400’s effects are sent up USB 1 and 2.
MONO - All input sources that are routed through the Vx400’s effects are summed to mono and sent up

USB 1. Nothing is sent up USB 2
effect - The Effect signal is sent up USB 1 and 2. Stereo track gets recorded.
SUM+DM - All input sources that are routed through the Vx400’s effects are summed to mono and sent up

USB 1. Dry mic is sent up USB 2.
SUMins - All input sources that are routed through the Vx400’s effects are summed to mono and sent up

USB 1. Dry instrument signal is sent up USB 2.
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Dmic+i - Dry Mic signal sent up USB 1. Dry Instrument signal sent up USB 2.
drymic - Dry Mic signal sent up USB 1. Nothing is sent up USB 2.
DRYlin - Dry Line Left signal is sent up USB 1. Dry Line Right signal is sent up USB 2. Stereo track gets

recorded.
DRYins - Dry Instrument signal is sent up USB 1. Nothing is sent up USB 2.
DRUMS - Vx400 drum playback is sent up USB 1. Nothing is sent up USB 2.
REmic - Playback from Pro Tracks™ is sent from the computer back through the Vx400’s effects 

processing, and then sent back up USB 1 and 2 to be recorded. See Re-micing a Vocal Track
on page 28 for more information on how to use this setting.

USB 3-4 Source
USBOFF - USB 3 and 4 are disabled.
Dmic+i - Dry Mic signal is sent up USB 3. Dry Instrument signal is sent up USB 4.
drymic - Dry Mic signal is sent up USB 3. Nothing is sent up USB 4.
DRYlin - Dry Line Left signal is sent up USB 3. Dry Line Right is sent up USB 4.
DRYins - Dry Instrument signal is sent up USB 3. Nothing is sent up USB 4.
DRUMS - Vx400 Drum playback is sent up USB 3. Nothing is sent up USB 4.

The following diagrams show how signals are routed through the Vx400’s effects and out the USB port
for recording purposes:

Mic Signal Routing
The microphone signal is routed from the mic input through the Vx400s effects processing and then to
the pairs of outputs. The signal sent up USB can be tapped off either at the input (USB Send Path A),
or after the different Effects modules (USB Send Paths C or D). Signals recorded from USB Send
Path A can be played back later through the Vx400 for re-micing. See Re-Micing a Vocal Track on page 28
for more information on how this feature works.

Mic USB Source Mapping
The microphone signal has three paths in which it can travel up the USB port to the computer. Path A
taps the mic signal off right at the input and sends unprocessed signal up to the USB port. Path C taps
the mic signal after the Effects modules except the Delay and Reverb. Path D taps the mic signal at the
output of the Vx400 and can include any effects processing that may be used. Below is a matrix to show
where the signal is tapped based on how the Mic, USB 1-2 Source, and USB 3-4 Source settings are
configured.

Microphone Input Mic
Model Comp Mic Pre

Voice
EQ

Noise
Gate Effects Delay Reverb

XLR Left Output
XLR Right Output

1/4" Left Output
1/4" Right Output

USB Dry
Send Path

A USB Re-Mic 
Return Path

B USB Send
Path

C USB Playback 
Return Path

EUSB Send
Path

D
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Instrument Signal Routing
The instrument signal can be routed in different ways through the Vx400. insoff disables the 
instrument input from being heard but dry instrument signal can still be recorded. insdry routes the
instrument signal around the Vx400’s effects processing and mixes it in at the outputs. insrvb routes
the instrument signal only through the Vx400 Delay and Reverb modules. insfx routes the instrument
signal through all of the Vx400’s effects.

Instrument USB Source Mapping
The instrument signal, as can be seen in the previous Instrument Signal Routing diagram, has two paths in
which it can travel up the USB port to the computer. Path F taps the instrument signal off right at the
instrument input and sends unprocessed signal up to the USB port. Path C taps the instrument signal
after the different Effects modules except the Delay and Reverb. Path D taps the signal at the output of
the Vx400 and can include any effects processing that may be used. Below is a matrix to show where the
signal is tapped based on how the Instrument, USB 1-2 Source, and USB 3-4 Source settings are
configured.
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Line Signal Routing
The line signals, like the instrument signal, can be routed in different ways through the Vx400. linoff
disables the line inputs from being being heard but dry line signal can still be recorded. lindry routes
the left and right line signals around the Vx400’s effects processing and mixes them in at the left and right
outputs respectively. linrvb routes the line signals only through the Vx400 Delay and Reverb modules.
linefx sums the left and right line input signals together and then routes this signal through all of the
Vx400’s effects.

Line USB Source Mapping
The line input signals, as can be seen in the previous Line Signal Routing diagram, has two paths in which
they can travel up the USB port to the computer. Path G taps the line input signals off right at the line
input and sends unprocessed signal up to the USB port. Path C taps the line input signals after the 
different Effects modules except the Delay and Reverb. Path D taps these signals at the output of the
Vx400 and can include any effects processing that may be used. Below is a matrix to show where the 
signal is tapped based on how the Line, USB 1-2 Source, and USB 3-4 Source settings are configured.
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Using Pro Tracks™
When Pro Tracks is first launched after installation, you will have to configure the MIDI device and Audio 
settings to recognize the Vx400 as the hardware you want to use. These procedures must be followed to
ensure you will be able to record audio through all of the Vx400’s inputs and to enable the hands-free
recording capabilities the Vx400 offers.

NOTE: Read the Software Installation sheet that came packaged with the Vx400 for instruc-
tions on installing USB drivers before connecting the Vx400 to the USB port on your computer
and using Pro Tracks.

Installing Pro Tracks Software
Pro Tracks™ software must be installed on your computer in order to use the recording capabilities of
the Vx400. To install Pro Tracks, please consult the installation instructions provided with the Pro Tracks
installation CD.

Setting Up the DigiTech USB Control  
The Vx400 uses MIDI commands through the USB connection to communicate with Pro Tracks. These
commands are used to determine which USB 1-2 Source and USB 3-4 Source settings have been selected
so that Pro Tracks can function properly when using the Vx400’s hands-free recording features. To 
configure Pro Tracks’ MIDI settings for use with the Vx400 follow the steps outlined below:

1. Start Pro Tracks application on your computer.
2. If the Tip of the Day window appears, click the Close button.
3. If no previous MIDI outputs have been selected, the No MIDI Outputs Selected window will

appear. Click the Choose MIDI Outputs Now button. The MIDI Devices window will open.
4. Under both Input and Output Selections, choose DigiTech USB Control. Do not select DigiTech

USB X-Edit™ or any other available selections. Click the Move Selected Devices to Top button.
5. Click the OK button and the window will close.
6. If the Quick Start window appears, click the Close button.

Setting up the Vx400 for Hands-Free Recording
1. From the Pro Tracks menu bar, select Options>Control Surfaces. The Control Surfaces window

will appear.
2. Click the * button to add a new control surface. The Control Surface Settings window will open.
3. In the Control Surface pull-down menu, select DigiTech Hands-Free. Verify that the Input and

Output port settings still have DigiTech USB Control selected. If they do not, do this now.
4. Click the OK button. Hands-Free should now be displayed as the Connected Surface in the

Control Surfaces Window.
5. Click the Close button.

Pro Tracks can now respond to the Vx400 for automated recording functions.
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Setting up Pro Tracks™ for Vx400 Audio
1. From the Pro Tracks menu bar, select Options>Audio. The Audio Options window will appear.

Click the Drivers tab.
2. Under the Input Drivers settings, select DigiTech USB 1-2 In/Out and DigiTech USB 3-4 In

Only and deselect all other options.
3. Under the Output Drivers settings, select DigiTech USB 1-2 In/Out and deselect all other

options.
4. Click the OK button.
5. Click the OK button when the window stating changes will be saved upon re-start appears.
6. Close the Pro Tracks application. When you are prompted to save changed, click No.
7. Re-start the Pro Tracks application again.
8. Close the Tip of the Day and Quick Start windows if they appear.
9. From the Pro Tracks menu bar, select Options>Audio.

10. Verify that the Playback and Record Timing Master settings have DigiTech USB 1-2 In/Out select-
ed. If not, select these now.

11. Click the Wave Profiler button at the bottom.
12. Click the Yes button to continue performing the tests.
13. When the profiling operation is successfully completed, click the OK button.
14. Click the OK button to close the Audio Options window if it is still open.

You are now ready to use the Vx400 with Pro Tracks recording software.

CAUTION: Do not disconnect power or disconnect the USB cable from the Vx400 or the
computer while the Pro Tracks software is running. Doing so can result in unpredictable
behavior from your computer’s operating system.
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Using the Vx400’s Footswitches for Recording
The Vx400’s footswitches are capable of controlling the Pro Tracks™ recording software, creating a hands-
free recording interface. To do this, the Vx400 must be connected to the computer via the included USB
cable and the Pro Tracks application must be installed and open.

Recording a Track or Tracks
To begin recording a track using the footswitches, follow these steps:

1. Start the Pro Tracks application.
2. From the Pro Tracks menu bar, select File>New. The New Project File window will appear.
3. From the New Project File window, select Normal - Hands-Free Session.
4. Put the Vx400 footswitches in Recorder mode by pressing and holding the UP and BYPASS

footswitches simultaneously until the display reads rec fs.
5. From the preset display, press and hold the SELECT button to enter the SETUP row in the Vx400’s

matrix. Otherwise, press the SELECT button several times until the setup row is selected.
6. Select the sources to record using the USB 1-2 Source knob (additional sources can be selected

using the USB 3-4 Source knob).
7. Press the RECORD footswitch. The Vx400’s display reads record. A track or tracks are

automatically inserted in the current session of the Pro Tracks software and recording on these tracks
begins.

8. To stop recording, press the STOP/UNDO footswitch. The Vx400’s display reads stop and Pro
Tracks stops recording. The wave data for the track(s) can now be viewed on your computer monitor.

Playing Back a Recorded Track
After a track or tracks have been recorded, playing them back is easy. If you want to start playback at the
beginning of a track or song but are someplace other than the end of the song, follow these steps:

1. Press the STOP/UNDO footswitch once. The Vx400 display will read rewind Pro Tracks will
rewind to the beginning of the current song.

2. Press the PLAY footswitch. The recorded track(s) will begin playing back.
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Recording Multiple Tracks
After tracks have been recorded, you may want to record other tracks that play along with them. To
record a new track or tracks with previously recorded tracks, follow these steps:

1. From the preset display, press and hold the SELECT button to enter the SETUP row in the Vx400’s
matrix.

2. Select the sources to record using the USB 1-2 Source knob (additional sources can be selected
using the USB 3-4 Source knob).

3. Press the STOP/UNDO footswitch twice. This will rewind to the beginning of the current song.
4. Press the RECORD footswitch. The Vx400’s display reads record. A track or tracks are

automatically inserted in the current session of the Pro Tracks software and recording on these tracks
begins.

5. To stop recording, press the STOP/UNDO footswitch.

Using the UNDO Footswitch to Erase a Track
You can undo the last take or previous tracks using the Vx400’s footswitches. To undo tracks, follow
these steps:

1. Press and hold the STOP/UNDO footswitch. The Vx400’s display reads undo, indicating the last
recorded track(s) are being deleted.

Re-Micing a Vocal Track
Using one of the Dry Microphone configurations for recording gives you the opportunity of playing that
dry take back into the Vx400 for re-processing. The advantages of having this feature are you can
experiment playing the dry vocal take back through different mic models, voice types, effects, or entirely
new presets once you have your other tracks recorded. This helps when trying to fit a vocal effect into a
mix after the song is assembled rather than recording with effects that can’t be undone.

To re-mic a track back through the Vx400, follow these steps:
1. Put the Vx400 footswitches in Recorder mode by pressing and holding the UP and BYPASS

footswitches until the display reads rec fs.
2. From the Pro Tracks menu bar, select File>New. The New Project File window will open.
3. Select the Normal-Hands-Free Session project template.
4. Select the SETUP row in the Vx400’s matrix.
5. Use the USB 1-2 Source knob to select drymic and USB3-4 Source to off.
6. Press the RECORD footswitch. The Vx400’s display reads record. A track is automatically inserted

in the current session of the Pro Tracks™ software and recording on this track begins.
7. To stop recording, press the STOP/UNDO footswitch. The Vx400’s display reads stop and

recording will stop. Press Stop again to rewind to the beginning of the track.
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8. In the Out box of the track you just recorded, select B(Digitech USB 1-2 In/Out).

9. In the tool bar press the Console View button to see the mixing console.

10. Pan the B - Mains Output hard left and the A - Mains Output hard right.

11. Select the SETUP row again and use the USB 1-2 Source knob to select REmic. This configures
the recording software to playback audio through the Vx400’s effects processing.

12. Press the PLAY footswitch. Put the footswitches back to Performance mode by pressing and holding
the UP and BYPASS footswitches simultaneously until the display reads updown. You can now
audition presets until you find one you like . Once you have done so, return to Recorder footswitch
mode.

13. Press the STOP/UNDO footswitch twice to rewind to the beginning of the track.
14. Press the RECORD footswitch and the recorder will now insert and record a stereo track of

processed mic or vocals.
15. To stop recording, press the STOP/UNDO footswitch.
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Vx400 Drums and MIDI
The Vx400’s Drum machine samples are mapped so that they may be triggered by MIDI notes played from
Pro Tracks™. Each of the drum patterns programmed in the Vx400 has been programmed as a MIDI track in
the Pro Tracks project file library.

Note mapping for each of the Vx400’s drum samples is as follows:

MIDI Note Sample
36/C3  . . . . . . . . . . . . .Kick
38/D3  . . . . . . . . . . . . .Snare 
42/F#3  . . . . . . . . . . . .Closed High Hat 
46/Bb3  . . . . . . . . . . . .Open High Hat

Recording the Vx400 Drums
The Vx400’s drum machine can be recorded using Pro Tracks. Each of the Vx400 drum patterns have
been saved as pattern template files which can be selected from the Pro Tracks project file library for
playback control of the Vx400’s drum samples. To record the Vx400 drums using the pattern templates
provided in Pro Tracks, follow these steps:

1. From the Pro Tracks menu bar, select File>New. The New Project File window will appear.
2. Select one of the DigiTech Vx400 drum templates and click the OK button. This will open up a new

recording session.
3. On the Vx400, use the either USB 1-2 Source or USB 3-4 Source knobs to select drums.
4. Press the RECORD footswitch. The Vx400’s display reads record. A new track is automatically

inserted in the current session of the Pro Tracks software and recording on these tracks begins.
5. To stop recording, press the STOP/UNDO footswitch.

You can use MIDI drum files for playing the Vx400 drum samples if you like as long as the events are
mapped to the MIDI notes shown above. The drum samples of the Vx400 only respond to MIDI messages
transmitted on MIDI channel 10, which is the default channel for General MIDI drums.

Playback Mix
The PLAYBACK MIX knob is an easy way to balance the Vx400’s processing with playback from the Pro
Tracks software using a single control. This function is only available when the Vx400 is connected to the
computer via USB and Pro Tracks is up and running. To change the Vx400/Playback mix, follow these steps:

1. Start playback of a session from Pro Tracks.
2. Turn the playback mix knob to balance the level of Vx400 vocal processing and playback level. When the

display reads USBMIX 0 indicates that only Vx400 signals will be heard. Rotating this knob clockwise, you
will begin to hear the playback level increase. USB VX50 indicates the Vx400/computer playback mix is a
50/50 mix of both signals. Continuing to rotate the knob clockwise will decrease Vx400 level. Vx MIX 0
indicates that only playback from the computer will be heard.
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USB 1-2 Level /USB 3-4 Level
The USB 1-2 LEVEL and USB 3-4 LEVEL knobs are used for boosting or cutting the amount of signal
sent out the USB port to the computer. These controls are to be used if the signal level of the input source
(mic, line, instrument) isn’t optimized into your recording software (consult the Pro Tracks User’s Guide for
information on proper recording levels). If the signal is too hot to Pro Tracks, use these controls to decrease
the level. The USB 1-2 Level and USB 3-4 Level knobs control the level for each USB pair of outputs so for
example, if summic is the selected USB 1-2 Source, increasing the level for the mic 6dB going up USB 2 will
also increase the summed signal by 6dB going up USB 1. To increase or decrease the level of audio going up
to the computer, follow these steps.

1. Sing/play through the Vx400 and check the level of signal reaching the recording software (consult the Pro
Tracks User’s Guide for information on how to view recording signal levels).

2. Use which ever USB Level knob to boost or cut the signal level going to the recording software. The
boost/cut range are -6db (usb1-2 -6) to +24dB (usb1-2 24).

Using the RPxFC for Recorder Functions

The Vx400 is equipped with a footswitch jack that lets you connect an optional RPxFC for controlling the
Vx400’s recorder. This 3-button footswitch features functions for STOP/UNDO, RECORD, and PLAY.
The RPxFC is an ideal companion for recording as it lets you leave your Vx400 footswitches setup for
changing presets while the RPxFC is used specifically for controlling the Pro Tracks recording software. Use
only a TRS stereo 1/4” cable when connecting the RPxFC to the Vx400.

The RPxFC functions are exactly the same as the Vx400 footswitches when it is in Recording mode. Refer to
section Using the Vx400’s Footswitches for Recording for operating instructions.
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Factory Reset
This function resets the Vx400 to its original factory settings. This procedure erase all custom user presets,
and recalibrate the Expression Pedal.

ATTENTION: Performing this function erases all user-programmed data. Be sure you want to
erase the memory and start fresh before continuing with this procedure.

The procedure for performing a Factory Reset is as follows:
1. Disconnect the power supply from the Vx400.
2. Press and hold the Select button while re-connecting the power to the Vx400.
3. When the display reads reset?, release the Select button and press the Store button. The display reads

reset indicating that the Vx400 has reset the original factory settings. At this point, the Vx400 auto-
matically advances to the Expression Pedal calibration menu. Follow steps 4 through 7 of the Expression
Pedal calibration section.

Expression Pedal Calibration
The Expression Pedal needs to be recalibrated after a factory reset. This function is automatically prompted
after a factory reset. In the event the pedal’s calibration fails, or if the pedal does not function properly, it can
be re-calibrated using the Pedal Calibration function. This does not erase the User Presets. The procedure
for Calibrating the Expression Pedal is as follows:
1. Disconnect the PS0913B power supply from the power jack on the Vx400.
2. Press and hold the Down Footswitch while re-connecting the power.
3. Continue to hold the Down Footswitch until the display briefly reads calib (calibration).
4. When the display reads TOE DN, rock the Expression Pedal forward to the toe down position.
5. Press any footswitch. The display reads toe up.
6. Rock the Expression Pedal back to the toe up position.
7. Press any footswitch. The display reads VSWTCH indicating you have entered the V-Switch Sensitivity menu.
8. If you do not want to adjust the V-Switch sensitivity, press any footswitch to return to Performance Mode.

Note: If error displays, an error has occurred and steps 4 through 8 should be repeated.

V-Switch Sensitivity
If you want to adjust the sensitivity setting of the V-Switch, follow steps 1 through 7 of Calibrating the
Expression Pedal and then follow the steps listed below:
1. When the display reads VSWTCH, rock the Expression Pedal forward (toe down) and apply extra pressure

on the toe of the pedal until the display reads DONE.
2. When display alternates between DONE (with the V-Switch sensitivity value in the numeric Display) and

VSWTCHOn (or VSWTCHOf depending on whether the V-Switch is on or off), you can audition the 
V-Switch sensitivity by applying pressure to the toe of the Expression Pedal.

3. Rotate the Number 5 Knob to change the value of the V-Switch sensitivity. You can audition the new value
by applying pressure to the toe of the Expression Pedal.

4. Once the sensitivity value is selected, press any footswitch. The Vx400 returns to Performance Mode and
your settings are automatically saved.
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Audio playback from Pro Tracks™ has pops and clicks.
•  Try the Wave Profiler under Options->Audio. This seems to fix most problems. Otherwise, try using MME

drivers in the Options->Audio->Advanced, Driver Mode selection. These are the safest drivers but also
have the most latency.

•  Try increasing the latency slider in the audio settings.

Hands-Free recording on Vx400 doesn’t work or has stopped working.
•  If it was working at one point but has stopped working, try exiting  Pro Tracks and then restarting it (make sure

to save your project).
•  Cycle power to the Vx400 before entering  Pro Tracks or X-Edit.
•  If it has never worked at all, there is a problem with USB MIDI  The most probable causes are using incorrect or

incorrectly installed drivers and/or .dll or a bad USB cable.
•  See the section on driver installation.

I can’t hear audio playback from Pro Tracks.
•  If the ‘Remic’ mode in the Vx400 is active try switching to a different mode like ‘Stereo’.
•  Make sure the faders in  Pro Tracks are turned up.
•  Check that the tracks you want to playback are un-muted.
•  Go to Options->Audio->Drivers and under output drivers, select ‘DigiTech USB 1-2 In/Out’ and de-select

everything else.
•  See the section on driver installation.

My Vx400 doesn’t record to Pro Tracks.
•  Go to Options->Audio->Drivers and under input drivers, select ‘DigiTech USB 1-2 In/Out’ and ‘DigiTech

USB 3-4 In Only’ De-select everything else.
•  Make sure the proper drivers are installed.
•  See the section on driver installation.
•  For an initial track, make sure ‘Remic’ mode in the Vx400 is not used.

I can’t get Re-Micing to work.
•  See the Re-Micing a Track section of this user’s guide.

Pro Tracks intermittently locks up.
•  Close any other open programs besides Pro Tracks. Check "Task Manager" to make sure there are no hidden

programs running.
•  Try reducing the number of plug-ins and soft-synths.
•  Increase the amount of memory in your system.
•  Get a faster hard drive.
•  Put your audio data on a different hard drive from your OS and applications.
•  Get a faster computer.
•  Please refer to the system requirements section.

Where did my wave files go?
•  Wave files all get saved to the folder specified in Options->Global, Audio Data.

My waves are low/too high in level.
•  The recording signal level can be boosted or reduced using the USB1-2 and USB3-4 level controls.

Pro Tracks playback is louder than my voice.
•  You can adjust the mix of playback versus microphone by using the Playback mix knob.
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Trouble Shooting Guide
I get audio dropout while I’m recording.

•  Try increasing the latency slider in the Audio settings.
•  Try reducing the number of tracks in your project (mute won't help, you either have to "archive" the tracks, or

delete them) 
•  Close any other open programs besides  Pro Tracks check Windows Task Manager to make sure there are no

hidden programs running.
•  Try reducing the number of plug-ins and soft-synths.
•  Increase the amount of memory in your system.
•  Get a faster hard drive.
•  Put your audio data on a different hard drive from your OS and applications.
•  Get a faster computer.

When I launch X Edit, it can’t find the Vx400.
•  Make sure your drivers are loaded correctly and that the USB cable is inserted securely.
•  See the section on USB Driver installation.

I hear doubling of the playback.
•  Input monitoring is probably active. Go to Options->Audio->Input Monitoring to disable.

Mid, MidFreq. and Treble controls are not working.
•  When USB is connected, the Mid, Mid Freq. and Treble controls function as Playback Mix, USB 1-2 Level, and

USB 3-4 Level controls. The tone controls can still be accessed from the editing matrix or from X Edit.

My instrument input didn’t record.
•  Dry instrument can only be recorded on a separate track, not as part of a mix. To record the instrument in, go to

the setup level of the matrix and select DRYINS in USB1-2 Source or USB3-4 Source.
•  Instrument with reverb or effects can be recorded as a mix with the microphone. The Mic setup must be set to

either insrVB or Ins FX.

My drums didn’t record.
•  Drums can only be recorded on a separate track, not as part of a mix. To record drums, go to the setup level of

the matrix and select Drums in USB1-2 Source or USB3-4 Source.

My line inputs didn’t record.
•  Dry line inputs can only be recorded on a separate track, not as part of a mix. To record line inputs, go to the

setup level of the matrix and select DRYLIN in USB1-2 Source or USB3-4 Source.
•  Line with reverb or effects can be recorded as a mix with the microphone. The Line selector must be set to either
LINRVB or LINEFX.

I get dropout when I change presets during recording/playback.
•  Changing presets during recording/playback will cause dropout of audio.

My mic/line inputs had dropout while I was recording.
•  Changing presets while recording will cause dropout of audio to and from the computer.

Pro Tracks won’t launch.
•  This was probably caused by interrupting the USB connection while in a previous  Pro Tracks session. You must

reboot your system to fix this problem.

I don’t hear playback from USB 3-4.
•  Playback is only available on USB 1-2. USB 3-4 is used for additional track recording - like dry instrument, mic,

drums, etc.
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Appendix
CC Parameter List
CC Parameter
12 MIC ON/OFF
13 MIC SOURCE
14 MIC MODEL
15 COMP ON/OFF
16 COMP TYPE 
17 COMP GAIN 
18 VOICE ON/OFF          
19 VOICE TYPE       
20 VOICE PARAM1        
21 VOICE PARAM2         
22 VOICE LEVEL        
23 VOICE BYPASSLVL          
24 EQ MIDFREQ         
25 EQ BASS         
26 EQ MIDRANGE      
27 EQ TREBLE         
28 GATE ON/OFF       
29 GATE THRESH         
30 FX ON/OFF    
31 FX TYPE           
32 FX PARAM1         
33 FX PARAM2     
34 FX LEVEL/MIX           
35 DLY ON/OFF      
36 DLY TYPE           
37 DLY TIME      
38 DLY FEEDBACK        
39 DLY LEVEL        
40 RVB ON/OFF        
41 RVB TYPE          
42 RVB DAMP          
43 RVB DECAY   
44 RVB LEVEL      
45 PDL1 ASSIGN 
46 PDL1 MIN     
47 PDL1 MAX         
48 PDL2 ASSIGN      
49 PDL2 MIN        
50 PDL2 MAX         
51 PDL3 ASSIGN
52 PDL3 MIN     
53 PDL3 MAX     

CC Parameter
4 GLB PEDAL1POSITION
7  GLB MASTER LEVEL
75 GLB INSTRUMENT ROUTE
76 GLB LINEIN ROUTE
77 GLB USB1 ROUTE
78 GLB USB2 ROUTE
79 GLB OUTPUT ROUTE
80 GLB USB1 LEVEL
81 GLB USB2 LEVEL
82 GLB USB MIX
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Appendix
Factory Preset List

Specifications:
Inputs:
Instrument In; 1/4” Unbalanced
Mic In: XLR Balanced w/Phantom Power
Line Inputs: 1/4” Balanced TRS
CD/Monitor: 1/8” Stereo TRS
Footswitch: 1/4” Stereo TRS
USB 1.1

Outputs:
Line Outputs: 1/4” Unbalanced 
Line Outputs: XLR Balanced
Headphone: 1/8” Stereo TRS
USB 1.1

A/D/A:
24 bit Delta Sigma Converters

Drum Machine:
30 Patterns + Metronome 

Simultaneous Effects:
up to 8

Power Consumption:
10 Watts,

Current Draw:
675mA AC 

Power Supply:
9 VAC, 1300mA 
DigiTech PS0913B - 100 (100V ~ 50/60Hz)
DigiTech PS0913B - 120 (120V ~ 60Hz)
DigiTech PS0913B - 230 (230V ~ 50Hz)
DigiTech PS0913B - 240 (240V ~ 50Hz)

Preset Memory:
40 User Presets
40 Factory Presets 

Effects:
Microphone Models, Compressor, Noise Gate, Mic Pre /
Voice, EQ, Chorus, Flanger, Phaser,Tremolo,Vibrato, Strobe,
Doubler, Envelope, Pixelator, Detune, Pitch,Whammy™,
Delay, and Reverb.

Dimensions:
8.5" L x 13" W x 2.25" H

Weight: 4.65 lbs.
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